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Capillary Isoelectric Focusing (cIEF)
Kit 1
The Capillary Isoelectric Focusing (cIEF) Kit provides the reagents to separate proteins by their
differences in isoelectric point (pI).

This document provides instructions for sample preparation with the Capillary Isoelectric
Focusing (cIEF) Kit. It also provides instructions for data acquisition with the BioPhase software
and the Waters Empower™ software with the BioPhase 8800 driver for Empower™. This
document also provides instructions for analysis of data acquired with BioPhase software.
Analysis of data acquired with the Waters Empower™ software must be done using the Waters
Empower™ software.

Use the information in this application guide as a starting point. As required, change injection
time, voltage, injection type, or other parameters to find the best conditions for your needs.

Note: For instructions for safe use of the system, refer to the document: Operator Guide.

Safety
Refer to the safety data sheets (SDSs), available at sciex.com/tech-regulatory, for information
about the proper handling of materials and reagents. Always follow standard laboratory safety
guidelines. For hazardous substance information, refer to the section: Hazardous Substance
Information.

Intended Use
The Capillary Isoelectric Focusing (cIEF) kit is for laboratory use only.

Introduction
A cIEF separation consists of two steps, focusing and mobilization. Focusing creates a pH
gradient across the capillary. Mobilization is the movement of the sample and the pH gradient
past the detection window. At the start of a cIEF separation, the entire capillary is filled with
the sample, a mixture of ampholytes, stabilizers, pI markers, and the protein of interest. During
focusing, one capillary end is submerged in anolyte and the other in catholyte. Next, the system
applies voltage across the capillary. A pH gradient forms through the introduction of hydronium
ions from the anodic side of the capillary and hydroxyl ions from the cathodic side. The cathodic
stabilizer migrates toward the cathodic side of the capillary. The cathodic stabilizer fills the outlet
side of the capillary, thereby forcing the ampholytes and protein sample to focus between the
capillary inlet and the detection window.
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The mechanism of focusing is bi-directional. The pH gradient forms at the capillary ends and
then progresses toward the center of the capillary where both anodic and cathodic sides merge.
With bi-directional focusing, sample peaks are often detected during focusing. Unmerged peaks
detected during mobilization indicate incomplete focusing of the pH gradient.

Figure 1-1 pH Gradient Inside a Capillary

Item Description

1 Anolyte, pH 1.4

2 Anode

3 Anodic Stabilizer

4 Cathodic Stabilizer

5 Cathode

6 Detection window

7 Catholyte, pH 13

The following figures show a simulation of the focusing the process over time. Refer to the
figures: Figure 1-2 to Figure 1-6.
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Figure 1-2 Simulation of Focusing Process at Time 0

Figure 1-3 Simulation of Focusing Process at 30 Seconds

Figure 1-4 Simulation of Focusing Process at 2 Minutes
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Figure 1-5 Simulation of Focusing Process at 4 Minutes

Figure 1-6 Simulation of Focusing Process at 6 Minutes

After the pH gradient is formed, the capillary contents are mobilized toward the outlet to detect
the pI markers and the separated protein sample. Pressure, gravity, or chemical mobilization can
be used to mobilize the pH gradient past the detection window. The procedure described in this
guide uses chemical mobilization.

At the beginning of the mobilization step, the capillary outlet moves from the well with a catholyte
to a well with chemical mobilizer and then the system applies a voltage across the capillary.
During mobilization with acetic acid, hydronium ions are introduced from the anodic side of the
capillary, while acetate ions are introduced at the cathodic side. As a result, the pH gradient is
titrated from basic to acidic and the proteins become positively charged. The sample is detected
as it passes the capillary window and migrates toward the cathode.

Workflow
The workflow consists of the following steps:

1. Determine the number of samples to be analyzed and the number of replicates.

2. For BioPhase software users:

a. Create or modify the methods. Refer to the section: Methods.

Capillary Isoelectric Focusing (cIEF) Kit

Application Guide
RUO-IDV-05-8651-C

Capillary Isoelectric Focusing (cIEF) Kit For the
BioPhase 8800 System

9/91



b. Create the sequence and the sample and reagent plate layouts. Refer to the section:
Create the Sequence.

3. For Waters Empower™ software users:

a. Import BioPhase software methods. Refer to the section: Import the BioPhase Software
Methods to Create the Instrument Methods.

b. Create the sample set methods and the sample and reagent plate layouts. Refer to the
section: Create the Sample Set Method.

4. Prepare the samples. Refer to the section: Prepare the Samples.

5. Use the sample and reagent plate layouts to prepare the plates.

6. Put the plates in the BioPhase 8800 system. Refer to the sections: Load the Sample Inlet
and Outlet Plates and Load the Reagent Inlet and Outlet Plates.

7. Start data acquisition.

• (BioPhase software) Start the sequence from the front panel. Refer to the section: Run
the Samples.

• (Waters Empower™ software) Start the sample set method from the Waters Empower™

software with the BioPhase 8800 driver for Empower™. Refer to the section: Start the
Sample Set Method.

8. Analyze the data.

• (BioPhase software) When the sequence is complete, analyze the data with the
BioPhase Analysis software. Refer to the section: Analyze the Data.

• (Waters Empower™ software) When the sample set method is complete, analyze the data
with the Waters Empower™ software. For data analysis instructions, refer to the Waters
Empower™ software guides and help file.

Capillary Isoelectric Focusing (cIEF) Kit

Capillary Isoelectric Focusing (cIEF) Kit For the
BioPhase 8800 System
10/91

Application Guide
RUO-IDV-05-8651-C



Required Equipment and Materials 2
Note: For items with a reorder part number, sometimes the reorder quantity is different than the
quantity in the kit.

Table 2-1 Capillary Isoelectric Focusing (cIEF) Kit (PN C30101)

Component Quantity Reorder Part
Number

cIEF Anodic Stabilizer (31.2 mg of iminodiacetic acid each
vial)

4 N/A

cIEF Anolyte (100 mL) 1 N/A

CE Grade Water (140 mL) 4 C48034

cIEF Cathodic Stabilizer (130.5 mg of arginine each vial) 4 N/A

cIEF Catholyte (60 mL) 1 N/A

cIEF Chemical Mobilizer (100 mL) 1 N/A

cIEF Gel (60 mL) 1 477497

cIEF Formamide (60 mL) 1 N/A

cIEF Neutral Capillary Conditioning Solution (60 mL) 1 530613

cIEF Urea (30 g) 1 N/A

Table 2-2 Additional Supplies from SCIEX

Component Quantity Part Number

(Optional) Tris Buffer (50 mM, pH 8) (100 mL) 1 477427

Capillary cartridge coolant (450 mL) 1 359976

cIEF Peptide Marker Kit (pI 4.1, pI 5.5, pI 7.0, pI 9.5, pI
10.0), (140 µL each)

1 A58481

BioPhase 8800 neutral coated capillary cartridge
(50 µm i.d. × 30 cm capillaries)

1 5080119

BioPhase 8800 outlet plates 20 5080315

BioPhase 8800 reagent plates 20 5080314

BioPhase 8800 sample plates 20 5080313

Required Equipment and Materials

Application Guide
RUO-IDV-05-8651-C

Capillary Isoelectric Focusing (cIEF) Kit For the
BioPhase 8800 System

11/91



Table 2-2 Additional Supplies from SCIEX (continued)

Component Quantity Part Number

BioPhase 8800 Starter Plate Pack (4 sample plates, 4
reagent plates, 8 outlet plates)

1 5080311

Table 2-3 Additional Required Reagents or Supplies

Description Vendor Part Number

(Optional) Amicon Ultra-4 Centrifugal Filter Unit with
Ultracel-10 membrane

MilliporeSigma UFC801024

(Optional) MicroCon-10 kDa Centrifugal Filter Unit with
Ultracel-10 membrane

MilliporeSigma MRCPRT010

(Optional) MicroCon-30 kDa Centrifugal Filter Unit with
Ultracel-30 membrane

MilliporeSigma MRCF0R030

(Optional) Monoclonal IgG System Suitability United States
Pharmacopoeia

1445550

Acrodisc 32 mm syringe filter with a 5 μm pore-size
membrane

Pall 4650

Pharmalyte pH 3-10 carrier ampholytes Cytiva 17-0456-01

X-Pierce Film USA Scientific 2997-0100

Storage Conditions
Note: For storage conditions for prepared reagents, refer to the preparation instructions.

• Upon receipt, store the following at 2 °C to 8 °C:

• cIEF Anolyte

• cIEF Catholyte

• cIEF Chemical Mobilizer

• cIEF Gel

• cIEF Neutral Capillary Conditioning Solution

• cIEF Formamide

• Store the remainder of the kit contents at room temperature.

Required Equipment and Materials
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Customer-Supplied Equipment and Supplies
• Powder-free gloves, neoprene or nitrile recommended

• Safety glasses

• Laboratory coat

• Appropriate centrifuge

• Vortex mixer

• Pipettes and appropriate tips

For reagent plate preparation a repeater pipette or equivalent is recommended.

• Disposable syringes, 10 mL

• Centrifuge with swinging-bucket rotor to hold plates

• Analytical balance

• Conical centrifuge tubes, 15 mL

• Weigh boats

Required Detector
A UV detector equipped with a 280 nm filter is required.

Required Cartridge
CAUTION: Potential Wrong Result. If a cartridge is used with the Capillary Isoelectric
Focusing (cIEF) kit, then do not use the same cartridge for another application. If the
same cartridge with different buffers and sample types is being used, then sample
carryover, nonspecific binding, and poor separation can occur.

A BioPhase 8800 neutral coated capillary cartridge with 50 µm i.d. × 30 cm capillaries is
required.

Refer to the table: Table 2-2.

Condition the Capillaries
• One day before a new cartridge is used, use the cIEF New Cartridge Condition method to

condition the capillaries.
This step serves to rehydrate the neutral coating of the capillaries.

Required Equipment and Materials
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Methods and Sequences 3
For Systems That Use the BioPhase Software

Note: If the validated methods and sequences are not included with the software, then they are
available for download from the SCIEX web site. Refer to the section: Download and Configure
the Required Files (BioPhase Software). The methods can also be created manually with the
BioPhase software. Refer to the section: Methods.

The following methods and sequence are required.

• Conditioning methods:

• cIEF New Cartridge Condition: Conditions the capillaries in a new cartridge.

• cIEF Condition: Conditions the capillaries as part of a sequence.

• cIEF Separation: Does the separation with the recommended cIEF sample composition with
Pharmalyte pH 3-10 carrier ampholytes.

• cIEF Shutdown: Cleans the capillaries at the end of a sequence, rinses the capillaries for
storage, and then turns off the lamp.

• cIEF Sequence: A sequence template.

For Systems That Use the Waters Empower™ Software

Create the required instrument methods by importing the BioPhase software methods.

Note: If the methods are not included with the software, then they are available for download
from the SCIEX web site. Refer to the section: Download and Configure the Required Files
(Waters Empower™ Software). The methods can also be created manually with the Method
Editors for BioPhase System software. Refer to the section: Methods.

Create the Sequence
Note: If the Waters Empower™ software will be used to acquire the data, this procedure does not
apply. Refer to the section: Create the Sample Set Method.

Note: This procedure assumes familiarity with the BioPhase software. For detailed instructions,
refer to the document: Software Help System.

Methods and Sequences
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This procedure gives instructions for creating a sequence with a template supplied with the
BioPhase software. The template is set up for eight samples in the first column, and uses the
validated methods supplied with the software.

Sequences can also be created without a template. In most cases, a sequence should start
with a conditioning method, followed by separation methods, and then ending with a shutdown
method. The shutdown method should be assigned as the error recovery method. Refer to the
document: Software Help System.

Note: If the sequence includes replicate samples, then make that sure the replicates are in the
same row of the sample plate to decrease any capillary-to-capillary variation.

1. On the Home page of the BioPhase software, click Sequence Editor.

2. Click Open Sequence.
The Open a Sequence dialog opens.

3. Search for, and then select cIEF Sequence.

a. (Optional) Type a Start Date and End Date for the search or click the calendar icons,
select the dates, and then click Search.
The available project folders are shown in the Folder Name pane.

b. Click the cIEF Project project folder.
The available sequences in the project are shown in the table to the right.

c. Click cIEF Sequence in the table, and then click Open.
The Open a Sequence dialog closes, and then the Sequence Summary tab opens.

4. Above the Sequence Summary pane, click Edit.
The Sample Plate Setup tab opens.

5. If required, do any of the following:

• Add or remove samples.

• Clear a method assigned to a sample well.

• Assign a different method to a sample well.

• In the Sequence Summary table, assign the recovery method to a method in the
sequence. Typically, the shutdown method should be assigned as the recovery method.

For detailed instructions, refer to the document: Software Help System.

6. If required, edit the information in the Sequence Summary table.

Methods and Sequences
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Figure 3-1 Sequence Summary Table: cIEF Sequence

7. To view details of a run, click the + in the row with the run.

Figure 3-2 Sequence Summary Table Expanded

8. If required, change the information in the Sample Id and Data File columns.

9. To view the sample plate and reagent plate layouts, open the Plates Layout tab. If required,
change the reagent locations in the Reagent Plate.

10. To save the sequence, click SAVE, and then add the required information.

Note: The SAVE button is not available if there are errors. Resolve all of the errors in the
Validation pane, and then click SAVE.

11. (Optional) To print the sample plate and reagent plate layouts, do the following:

Methods and Sequences
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a. Click PRINT.
The Print Preview dialog opens.

b. Click Plate Layout Report, and then click Print.

c. Select the printing options, and then click OK.
The report is printed.

d. Click the close box, the × in the top right corner.
The Print Preview dialog closes.
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Prepare the Stock Solutions 4
Prepare the Cathodic Stabilizer Solution
1. Add 1.5 mL of CE Grade Water to a vial of cIEF Cathodic Stabilizer and then mix with a

vortex mixer until all of the solid material is dissolved.

2. Store the solution at 2 °C to 8 °C for up to 3 months.

Prepare the Anodic Stabilizer Solution
1. Add 1.5 mL of CE Grade Water to a vial of cIEF Anodic Stabilizer and then mix with a vortex

mixer until all of the solid material is dissolved.

2. Store the solution at room temperature for up to 90 days.

Note: Do not refrigerate the cIEF Anodic Stabilizer solution. If the cIEF Anodic Stabilizer
solution precipitates, then discard the vial. Failure to do so can result in loss of acidic peaks
and irreproducible detection times.

Prepare the 4 M Urea-cIEF Gel Solution
The protein sample might require urea to maximize the protein solubility and to minimize protein
precipitation and aggregation during focusing. If the protein is highly soluble (approximately
20 mg/mL to 25 mg/mL), then this solution is not needed. We recommend the use of the 4.0 M
urea-cIEF Gel solution for samples containing USP IgG.

Conversely, a high concentration of urea may lead to protein denaturation. If the protein
separation profile changes during replicates, the protein might be degrading due to too much
urea or cathodic stabilizer in the sample.

Make sure to optimize the urea concentration in the cIEF sample. Refer to the section: Tips for
Best Results.

1. Use an analytical balance to weigh 2.402 g of urea, and then add it to a 15 mL conical
centrifuge tube.

2. Add 7 mL of the cIEF Gel to the conical centrifuge tube and then secure the cap tightly.

3. Mix the tube with a vortex mixer until all of the solid material is dissolved.

4. Add enough of the cIEF Gel to make a total volume of 10.0 mL.

5. Mix the solution with a vortex mixer for few seconds.

6. Mix the solution by inverting the centrifuge tube three times.

Prepare the Stock Solutions
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7. Use an Acrodisc 32 mm syringe filter with a 5 μm pore-size membrane and a 10 mL
disposable syringe to filter the solution, and then collect the filtrate in a 15 mL conical
centrifuge tube.

8. Label the vial as "4.0 M urea-cIEF gel" with the preparation date.

9. Store the solution at 2 °C to 8 °C for up to 30 days.

Note: Discard the urea-cIEF Gel solution if left at room temperature for longer than 4 hours
or if it has a higher-than-normal electrical current value at the beginning of the focusing step.

Prepare the IgG Stock Solution
1. Add 400 µL of the CE Grade Water to the vial containing the USP IgG.

2. Mix the vial contents until the solution is clear.

3. Aliquot the solution in 8 µL portions.
When not in use, store at –35 °C to –15 °C for up to five years.

Prepare the Stock Solutions
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Prepare the Samples 5
CAUTION: Potential Wrong Result. If the Cathodic Stabilizer precipitated during storage,
then warm the vial in a water bath at room temperature, and then mix with a vortex mixer
until all of the solid material is dissolved. Failure to do so can result in early detection
times and unfocused peaks.

Tips for Best Results
Before preparing the samples, make sure to:

• Determine the protein concentration in the sample.

• If the protein is too concentrated, then it should be diluted.

• If the protein is too dilute, then it should be concentrated.

• If the sample has a high ionic strength (greater than 50 mM) , then it should be desalted.
Refer to the section: Perform a Buffer Exchange (Optional).

• One day before a new cartridge is used, use the cIEF New Cartridge Condition method to
condition the capillaries.

Prepare a Test Sample with the IgG Standard
Note: The following instructions give quantities for eight samples. For reference, quantities for
one sample are also given. For experiments with a different number of samples, modify the
quantities as appropriate.

1. Add the reagents specified in the following table to a clean, dry vial, and then mix the
solution in a vortex mixer.

Note: Because the ampholytes are dense, make sure to mix the solution thoroughly with the
vortex mixer. Alternatively, use a pipette to mix the solution or invert the tube multiple times.

The minimum sample volume is 100 µL. The maximum sample volume is 200 µL.

Table 5-1 Reagents for the USP IgG cIEF Sample

Reagent For 1 Sample For up to 8
Samples

4.0 M Urea-cIEF gel 200 µL 800 µL

cIEF Cathodic Stabilizer 25 µL 100 µL

Prepare the Samples
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Table 5-1 Reagents for the USP IgG cIEF Sample (continued)

Reagent For 1 Sample For up to 8
Samples

cIEF Anodic Stabilizer 3 µL 12 µL

Pharmalyte pH 3-10 carrier ampholytes 12 µL 48 µL

pI Marker 10.0 2 µL 8 µL

pI Marker 9.5 2 µL 8 µL

pI Marker 5.5 2 µL 8 µL

pI Marker 4.1 2 µL 8 µL

Monoclonal IgG System Suitability (USP IgG)
(5 mg/mL)

8 µL 32 µL

2. Use a microcentrifuge to spin the vial for a few seconds to bring the solution to the bottom of
the vial.
When not in use, store at 2 °C to 8 °C. Discard the unused portion.

Best Practices for Preparing Multiple Samples
To simplify sample preparation and minimize pipetting errors, we recommend that the user
prepare a master mix when analyzing multiple samples. For instructions to prepare samples with
a master mix, refer to the section: Prepare the cIEF Samples.

Start by specifying the number of samples to be prepared in the table. Increment the number of
samples by one, multiply each reagent volume by that number of samples, and then record the
result. As required, add or remove pI markers from those provided in the pI marker kit. Refer to
the table: Table 5-2.

Prepare the cIEF Samples
1. Prepare the master mix.

a. Use the following table to calculate the required reagent volumes. Refer to the table:
Table 5-2.

Prepare the Samples
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Table 5-2 cIEF Master Mix for Analyzing Multiple Samples

Reagent Volume per
Sample (μL)

Number of Samples Total Volume to
Be Measured

(μL)

4.0 M Urea-cIEF Gel 200 × (_________ + 1) =

cIEF Cathodic Stabilizer 25 × (_________ + 1) =

cIEF Anodic Stabilizer 3 × (_________ + 1) =

Pharmalyte pH 3-10 carrier
ampholytes

12 × (_________ + 1) =

pI marker 10.0 2 × (_________ + 1) =

pI marker 9.5 2 × (_________ + 1) =

pI marker 5.5 2 × (_________ + 1) =

pI marker 4.1 2 × (_________ + 1) =

Note: Do not add a pI marker close to the pI of the sample.

b. Use a pipette to add each reagent to a centrifuge tube.

c. Use a vortex mixer to mix the master mix for 15 seconds, and then use the centrifuge to
spin it down. Store the master mix at 2 °C to 8 °C, and then discard it at the end of the
day.

Note: Because the ampholytes are dense, make sure to mix the solution thoroughly
with the vortex mixer. Alternatively, use a pipette to mix the solution or invert the tube
multiple times.

2. Mix 248 μL of the cIEF master mix with 8 μL of sample at a protein concentration of 5 μg/mL
to 10 μg/mL.

3. Use a vortex mixer to mix the cIEF sample (master mix with protein) for 30 seconds,
and then spin it using a table-top microcentrifuge for 3 minutes at 3,500 g to remove any
precipitates.

Prepare a Test Sample with pI Markers
Note: The following instructions give quantities for eight samples. For reference, quantities for
one sample are also given. For experiments with a different number of samples, modify the
quantities as appropriate.

1. Add the reagents specified in the following table to a clean, dry vial, and then mix the
solution with a vortex mixer.
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Note: Because the ampholytes are dense, make sure to mix the solution thoroughly with the
vortex mixer. Alternatively, use a pipette to mix the solution or invert the tube multiple times.

The minimum sample volume is 100 µL. The maximum sample volume is 200 µL.

Table 5-3 Reagents for the pI Marker Test Sample

Reagent For 1 Sample For up to 8
Samples

4.0 M Urea-cIEF gel 200 µL 800 µL

cIEF Cathodic Stabilizer 25 µL 100 µL

cIEF Anodic Stabilizer 3 µL 12 µL

Pharmalyte pH 3-10 carrier ampholytes 12 µL 48 µL

pI Marker 10.0 2 µL 8 µL

pI Marker 9.5 2 µL 8 µL

pI Marker 7.0 2 µL 8 µL

pI Marker 5.5 2 µL 8 µL

pI Marker 4.1 2 µL 8 µL

2. Use a microcentrifuge to spin the vial for a few seconds to bring the solution to the bottom of
the vial.
When not in use, store at 2 °C to 8 °C. Discard the unused portion.

Perform a Buffer Exchange (Optional)
In cIEF, the presence of salts greater than 50 mM in the sample can lead to compression of
the pH gradient, altered focusing conditions, and damage to the capillary coating. To reduce the
negative effects that sample buffer components can have on cIEF separations, we recommend
that the buffer exchange be performed.

Note: A centrifugal filter unit with a 10 kDa molecular weight cutoff was used to validate this
procedure. If a different molecular weight cutoff is required, then choose a different filter, and
then adjust the centrifugation parameters, as required.

Note: For desalting or buffer exchange procedures that use a device from another manufacturer,
refer to the manufacturer User Guide.

Note: If a buffer other than eCap Tris Buffer is used, make sure that the buffer does not contain
any components that are ampholytic. Those components will focus during the run and might
interfere with the separation of the sample and affect the linearity of the pH gradient.
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1. Add 4 mL of the eCap Tris Buffer to 6 mL of CE Grade Water.

2. Add 500 µL of the protein (between 5 mg/mL and 10 mg/mL) to a centrifugal filter unit, and
then spin the vial for 5 minutes at 12,000 g.

3. Add 250 µL of the diluted eCap Tris Buffer prepared in step 1 to the retentate. Discard the
permeate.

4. Repeat from step 2 to step 3, twice.

5. Put the centrifugal filter unit in an inverted position in a clean microcentrifuge vial, and then
spin the vial in a centrifuge for 3 minutes at 2,000 g.

6. Prepare 50 µL aliquots at a protein concentration of 5 mg/mL to 10 mg/mL.
Store the aliquots at or below –15 °C.

Store the Samples (Optional)
Store the sample plates at 2 °C to 8 °C when not in use and at 10 °C when inside the BioPhase
8800 system. Minimize exposure to room temperature to prevent degradation of the urea or the
sample.
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Prepare the BioPhase 8800 System 6
Use the procedures in this section to prepare the BioPhase 8800 system to acquire data.

The procedures in this section assume that the system has already been properly installed and
initialized.

Tip! To save time, turn on the light source 30 minutes before starting the run so it can warm up.

Tip! On the front panel, set the sample storage temperature to 10 °C.

Load the Reagent Inlet and Outlet Plates
1. Add the reagents to the reagent inlet and outlet plates according to the reagent plate layout.

Refer to the figure: Figure D-4.

Use the volumes in the following table.

Note: For the outlet plate, make sure that the chamfered corner is on the upper right, and
then fill only the wells on the left side of the plate. The wells on the right side are for overflow
and must be empty.

Table 6-1 Reagents for the Reagent Inlet and Outlet Plates

Plate Reagent

Inlet plate 800 µL per well

Outlet plate • 2.8 mL per well of reagent for separation or wait actions

• 1.5 mL per well of CE Grade Water for waste positions

2. Put a film cover on the plates.

CAUTION: Potential System Damage. Do not use a heated plate sealer to apply the
seal. The heat might damage the surface of the plates, which might cause issues with
the pressure system.

Note: Only X-Pierce film from USA Scientific is validated. If a different film is used, then test
it before use.

3. Put the plates in a swinging-bucket rotor, and then spin them for 4 min at 30 g. Make sure
that the buckets are balanced.
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CAUTION: Potential Wrong Result. Do not load the plates in the system without
spinning them to remove air bubbles. The presence of air bubbles might cause the
separation to fail.

4. Make sure that there are no air bubbles present in the plates. If air bubbles are present,
then spin the plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 g. For the sample plate, the maximum
RCF is 375 g.

5. On the front panel, touch Eject Reagent.

Figure 6-1 Eject Reagent Button

The plate compartment opens.

6. Remove the film cover from the plates.

CAUTION: Potential System Damage. Do not load plates in the system before
removing the film cover. The presence of the film cover during a run might damage
the capillary tips.

7. If the plate compartment already contains reagent plates, then remove the reagent plates.

8. Align the notch in the reagent inlet plate with the tab, and then put the plate in the plate
carrier.

9. Make sure that the chamfered corner of the reagent outlet plate is in the top left, and then
put the plate in the back of the plate carrier.

10. Touch Load Reagent.

Figure 6-2 Load Reagent Button

The plate compartment closes.
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Load the Sample Inlet and Outlet Plates
1. Add the samples to the sample inlet plate according to the sample plate layout. Refer to the

figure: Figure D-3.
The recommended sample volume is 100 µL.

The minimum sample volume is 100 µL. The maximum sample volume is 200 µL.

2. To prevent damage to the capillary, if there are columns where not every well has sample,
then add between 100 µL and 200 μL of master mix to each empty well.
If a column has no samples, then the wells can be left empty.

3. Add the reagents to the sample outlet plate according to the sample plate layout. Refer to
the figure: Figure D-3.
The maximum volume is 2.0 mL.

Use the volume in the following table.

Note: For the outlet plate, make sure that the chamfered corner is on the upper right, and
then fill only the wells on the left side of the plate. The wells on the right side are for overflow
and must be empty.

Table 6-2 Reagents for the Sample Outlet Plate

Plate Reagent

Outlet plate • 1.5 mL of CE Grade Water per well

4. Put a film cover on the plates.

CAUTION: Potential System Damage. Do not use a heated plate sealer to apply the
seal. The heat might damage the surface of the plates, which might cause issues with
the pressure system.

Note: Only X-Pierce film from USA Scientific is validated. If a different film is used, then test
it before use.

5. Put the plates in a swinging-bucket rotor, and then spin them for 4 min at 30 g. Make sure
that the buckets are balanced.

CAUTION: Potential Wrong Result. Do not load the plates in the system without
spinning them to remove air bubbles. The presence of air bubbles might cause the
separation to fail.

6. Make sure that there are no air bubbles present in the plates. If air bubbles are present,
then spin the plates again at a higher relative centrifugal force (RCF).
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For the reagent plate, the maximum RCF is 1,000 g. For the sample plate, the maximum
RCF is 375 g.

7. On the front panel, touch Eject Sample.

Figure 6-3 Eject Sample Button

The plate compartment opens.

8. Remove the film cover from the plates.

CAUTION: Potential System Damage. Do not load plates in the system before
removing the film cover. The presence of the film cover during a run might damage
the capillary tips.

9. If the plate compartment already contains sample plates, then remove the sample plates.

10. Orient the sample plate so that the alignment notch in the plate aligns with the tab, and then
put the plate in the plate carrier.

11. Orient the sample outlet plate so that the chamfered corner is in the upper left, and then put
the plate in the back of the plate carrier.

12. Touch Load Sample.

Figure 6-4 Load Sample Button

The plate compartment closes.

Examine the Capillary Cartridge
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

CAUTION: Potential System Damage. Do not let the gel buffer or other reagents
crystallize on the electrodes, capillary ends, cartridge seals, or cartridge body. Electrolyte
salt crystals or precipitate can cause plugged capillaries, improper pressure sealing,
errors when injecting samples, arcing, or current leakage.
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1. Examine the electrodes, capillary tips, cartridge seals, and cartridge body interface before
use.

2. If there is liquid on the outside of the cartridge, then clean the cartridge with a damp lint-free
laboratory wipe. After cleaning, make sure to dry the cartridge.

Note: Do not use soap or detergent to clean the cartridge.

3. If the capillary tips are blocked, then do this:

a. Use CE Grade Water to clean the capillary inlets.

b. Use a lint-free laboratory wipe to wipe the capillary inlets carefully in an outward
direction.

4. Use a magnifying glass to examine both sides of the capillary window. If lint or other
particles are present, then use short bursts of electronics-grade compressed air to remove
them. Do not use water or other liquids to clean the capillary window.

CAUTION: Potential System Damage. Do not use organic solvents, such as methanol
or acetone, to clean the capillary window. Organic solvents can dissolve the
adhesives, leaving residue on the capillary window that might interfere with the
detector.

5. Moisten a lint-free laboratory wipe or cotton swab with ethanol or isopropyl alcohol, and then
wipe the surface of the chip. Let the chip air dry before installing the cartridge.

Install the Cartridge
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

WARNING! Pinching Hazard. When opening the front panel, be careful not to put
fingers to the left of the front panel.

CAUTION: Potential System Damage. Make sure that the reagent plates are installed in
the system before installing the cartridge. Failure to do so might damage the cartridge.

1. If the cartridge was stored in the refrigerator, then let the cartridge equilibrate to room
temperature for approximately 30 min to prevent condensation in the system.

2. Remove the cartridge from the wetting tray.

3. Use a disposable laboratory wipe to dry the cartridge body to prevent arcing.

4. Turn the bottom of the cartridge up.

5. Use a disposable lint-free laboratory wipe to very gently dry the area where the capillaries
and electrodes emerge from the cartridge. Do not disturb the seals.
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Figure 6-5 Bottom of the Cartridge

Item Description

1 Outlet plate seal

2 Inlet plate seal

6. If the reagent plates are not installed in the system, then install them. Refer to the section:
Load the Reagent Inlet and Outlet Plates.

7. Open the front panel, and then put the cartridge in the system.

8. Close the front panel, and then touch EJECTED to lock the cartridge.

Figure 6-6 EJECTED Button
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If the cartridge run life has been exceeded, then a warning message is added to the front

panel log. To view the warning message, touch  on the front panel status area. The
cartridge can still be used or a new one can be installed.

The system moves the reagent plate so that the capillaries are in position over column 1,
and then raises the plate so that the capillary ends are immersed in CE Grade Water.

9. Examine the coolant level on the front panel. If required, add coolant into the fill port on the
system.
Refer to the section: "Add Capillary Cartridge Coolant" in the document: Operator Guide.
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Run the Samples 7
Start the Sequence from the Front Panel
To use the Waters Empower™ software, refer to the section: Start the Sample Set Method.

1. If required, load the cartridge, reagent plates, and sample plates.

2. On the front panel, touch RUN SEQUENCE.

Figure 7-1 RUN SEQUENCE Button

3. In the Projects pane, touch cIEF Project.

4. In the Available Sequences pane, touch cIEF Sequence in the list.

5. (Optional) To view the details of the method, sample plates, or reagent plates, touch
anywhere in the Method column.
To hide the details, touch the column or box again.

6. Touch Run Sequence.

Figure 7-2 Run Sequence Button

Run Sequence is not enabled if the sequence contains a method that is incompatible with
the system configuration.

The data files are saved at the location specified in the sequence.

If an error occurs during a run and an error recovery method is present in the sequence,
then the BioPhase 8800 system starts the error recovery method.

During the run, various actions are available. Refer to the section: Monitor the Run on the
BioPhase 8800 Front Panel.

When the run is complete, the Run Completed dialog opens.

Run the Samples

Capillary Isoelectric Focusing (cIEF) Kit For the
BioPhase 8800 System
32/91

Application Guide
RUO-IDV-05-8651-C



Figure 7-3 Run Completed Dialog

7. Touch OK to close the Run Completed dialog.

8. As required, store the cartridge. Refer to the section: Store the Cartridge After the Run.

Monitor the Run on the BioPhase 8800 Front
Panel
Use this procedure to monitor the sequence progress, and then, if required, pause or stop the
sequence.

To use the Waters Empower™ software, refer to the section: Monitor the Run in the Waters
Empower™ Software.

Note: The sequence shown in the following figures is for the purpose of illustration. It does not
show a sequence for the Capillary Isoelectric Focusing (cIEF) Kit.

1. Monitor the traces for the detector and the current to make sure that the sequence is
running.

2. If a problem is detected, then touch  to stop the run, and then, in the Warning dialog,
touch one of the following:

• Yes: Touch to start the error recovery method, if one is assigned.

• No: Touch if an error recovery method is not assigned.

Note: Stopping the run might result in loss of sample or reagent and damage to the
cartridge.

• To continue the run, touch Cancel.
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Figure 7-4 Warning Dialog

CAUTION: Potential System Damage. If the run is stopped and will not be resumed,
then use the shutdown method to rinse the capillaries before storing the cartridge. If
the capillaries are not rinsed, electrolyte salt crystals or precipitate can accumulate
and might cause plugged capillaries, improper pressure sealing, errors when
injecting samples, arcing, or current leakage.

CAUTION: Potential System Damage. Before starting the run again, make sure to
empty or replace the outlet plate to prevent overflow of reagent and possible damage
to the instrument.

CAUTION: Potential Wrong Result. Before starting the run again, prepare new reagent
plates. If the run has been stopped, then there might not be enough reagents
available to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, then before starting the run again, discard them. The samples
might have degraded.

3. If an error occurs, then touch OK in the error dialog that is shown.
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Figure 7-5 Run Sequence Error

Note: The shows an error at the Rinse action. The grey shading in the row above the
Rinse action indicates that the action is in progress or completed.

4. Review the error:

a. Touch  in the Events tab of the front panel log.
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b. Touch Initialize System to reinitialize the system, and then change the system status to
idle.

Figure 7-6 Sequence Error Events Log

5. If required, pause the run by touching Pause Run.
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Figure 7-7 Run Sequence in Progress

6. To continue the run, touch Cancel Pause.
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Figure 7-8 Restart the Run Sequence

7. To view the data while it is being acquired, touch  in the ribbon.

Note: The data in the following figure is for the purposes of illustration. It does not show
results for samples prepared with the Capillary Isoelectric Focusing (cIEF) Kit.
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Figure 7-9 Capillary View

8. (Optional) To zoom in on the data, do the following:

a. Touch Overlay.

b. Use two fingers to zoom in or out to view the electropherogram.

c. Use the hand icon to move the electropherogram.

Note: The zoom feature only works with the overlay view for detector and current.
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Figure 7-10 Zoom In or Out

9. Make sure that the message, Sequence run Completed Successfully, is shown
when the run completes. In the dialog, touch OK.

Figure 7-11 Run Completed
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Waste Disposal
WARNING! Biohazard or Toxic Chemical Hazard. Follow local directives to
dispose of chemicals, cartridges, reagent plates, sample plates, and the
remains of the prepared samples. They might contain regulated compounds
and biohazardous agents.

Store the Cartridge After the Run
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

Store the Cartridge for Less than Three Days
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method.
The shutdown method fills the capillaries with neutral capillary conditioning solution.

2. Store the cartridge for up to three days in the system with the capillary ends immersed in CE
Grade Water.

Note: If the cartridge has not been used for three hours or longer, then run the conditioning
method before doing a separation.

Store the Cartridge for More than Three Days
1. If the sequence or sample set method does not include the shutdown method, then perform

the shutdown method.
The shutdown method fills the capillaries with neutral capillary conditioning solution.

2. On the ribbon on the BioPhase 8800 system front panel, touch  (Loaded) and
then wait for about one minute.
Waiting lets the coolant return to the coolant reservoir before the cartridge is removed.

3. Remove the cartridge from the system, and then store it upright in the cartridge box at 2 °C
to 8 °C with the capillary ends immersed in CE Grade Water.

Note: Replace the CE Grade Water in the tray regularly to avoid microbial growth in the tray.

Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day, or if it has been stored for an extended

time, then use the cIEF Condition method to condition the capillary.
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Note: To prevent arcing, and before installing the cartridge in the system, carefully wipe off any
water from around the electrodes and cartridge body.
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Analyze the Data 8
Analyze the Data with an Analysis Parameters
File
Note: If the Waters Empower™ software will be used to acquire the data, then this procedure
does not apply.

The following instructions explain how to analyze data with the BioPhase Analysis software with
an analysis parameters file. An analysis parameters file contains all of the information required
to integrate the peaks and identify peaks in the data.

Note: This procedure assumes familiarity with the BioPhase software. For detailed instructions,
refer to the document: Software Help System.

Note: The analysis parameters files in this procedure are examples. The parameters might not
be optimal for all data files.

1. On the Home page of the BioPhase software, click Data Analysis.
The BioPhase Analysis software main window opens.

2. Click File > Open, select the data files to analyze, and then click Open.

3. In the Project toolbar, click , navigate to the analysis parameters files, and then click
Open.
Two analysis parameters files are available. Click the file that is appropriate:

• cIEF pI Markers Analysis Parameters

• cIEF USP IgG Analysis Parameters

4. Right-click , and then select Apply & Analyze (all).

The software applies all of the parameters in the Integration, Library, and Post Analysis tabs
to all of the data files, and then shows the results.

In the Files pane, the file name is shown in red to indicate that the data has been analyzed.
The number of peaks identified is shown in the Peaks column.

In the Data pane, the analysis results are shown in the table below the graph. At the top
of the table, RMS Noise, P-P Noise, and Drift are shown. In the graph, the baseline is
shown in red and the threshold is shown as a grey horizontal line. Any peaks identified in
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the analysis have a blue marker at the peak start, a red marker at the peal apex, and a
green marker at the peak end.

Peaks in the graph are shaded as follows:

• Green: The peak corresponds to a peak in the Marker Table on the Library tab.

• Blue: The peak corresponds to a peak in the Peak Table on the Library tab.

• Red: The peak is not a named peak.

Refer to the section: Examine the Results.

5. Show the peak names on the graph.

a. Right-click .
The Information Setup dialog opens.

b. Select Name and any other information to view on the graph, such as Cal MT, and then
click OK.

c. Click .

The peak names are shown on the graph. Refer to the section: Examine the Results.

The names are part of the analysis parameters file. To use different names, refer to the
section "Identify the Peaks" in the document: Software Help System.

6. Click in the Files pane below the list of files, and then press the Up and Down arrow keys to
view the data for each file in the Data pane.
If required, drag over a region on the graph to zoom in to see the details of the identified
peaks in that region.

Tip! To prevent having to zoom in on each data file, click  to apply the same zoom
settings to all of the data files.

7. Make sure that the integration is satisfactory. Adjust the integration parameters, and then
analyze the data again as required.

8. Examine the electropherogram for the peaks in the Marker Table and the Peak Table.

a. For each peak in the Marker Table and the Peak Table, make sure that the correct peak
is labeled in the graph.

b. As required, adjust MT in the Marker Table and MT (or Cal MT) in the Peak Table.

c. As required, adjust Tol and Crit, and then click .

• Tol is the tolerance for matching a peak in the graph to a peak in the Marker Table or
the Peak Table. Type % to use the tolerance as a percentage.
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• Crit is the peak characteristic to be matched.

• Ctr: The peak closest to the center of the range is matched.

• Ht: The tallest peak in the range is matched.

• Area: The largest peak in the range is matched.

d. When the peak assignments are satisfactory, right-click , and then select Apply &
Analyze (all).

The software applies the changes to all of the data files.

9. (Optional) Change the X-axis on the graph.

a. Click .

The graph is shown with isoelectric point on the X-axis.

b. Click .
The graph is redrawn so that the pI markers are shown in the order that they migrate,
from high to low pI.

10. (Optional) In the Project toolbar, click , type a name, select a location, and then click
OK.
The analysis parameters are saved to a file for later use.

11. (Optional) In the File toolbar, right-click , and then select Print (all).
The contents of the Data pane are printed in the current report template. For instructions to
create a report template, refer to the section "Configure a Report" in the document: Operator
Guide.

12. In the File toolbar, right-click , and then select Save (all).
All changes to the results, including the analysis parameters, are saved to the data files.

13. In the File toolbar, right-click , and then select Close (all).
All of the data files close.
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Examine the Results
Figure 8-1 pI Marker Sample

Figure 8-2 Monoclonal IgG System Suitability (USP IgG) Sample
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Review the Results on the Overlay Tab
The Overlay tab shows the graphs for the selected data files. This tab contains the statistics for
the selected data files, as well as the system suitability report.

Note: This section does not describe the system suitability function. For information about
system suitability, refer to the document: Operator Guide.

1. Open a set of data files and the appropriate analysis parameters file, and then analyze the
data. If required, adjust the analysis parameters until the results are satisfactory.

2. In the Files pane, click , and then open the Overlay tab.

Figure 8-3 Overlay Tab

The color of the trace in the graph corresponds to the color in the circle next to the file name
in the Files pane.

The thicker line is the trace that corresponds to the file selected in the Files pane.

3. Move the slider on the right side of the graph up or down to adjust the traces.

Note: To view the traces as a series of tiled graphs, move the slider all of the way to the top.
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4. Calculate the results for all of the files on the Overlay tab.

Figure 8-4 Results Table

Item Description

1 Reference file

2 Type of analysis

3 Save the results to a comma-separated file

a. Click the list on the right side of the Results Table header to select the type of analysis.

These options are available:

• Reference - All: In the Results Table, show statistics for every peak in the reference
file that is present in all of the other data files.

• Reference - Peak Table: In the Results Table, show statistics for every named peak
in the reference file that is present in all of the other data files.

• Named Peaks: In the Results Table, show statistics for all of the named peaks in any
of the data files.

• All Data (not displayed): Calculate but do not show statistics for all of the peaks in
all of the data files.

• System Suitability: If system suitability was enabled when the data was analyzed,
then show the system suitability report.

A peak in a data file is considered to be matched to a peak in the reference file if the
migration times of the peak apexes match within 5%.

b. Click the list on the left, and then select the reference file.

The reference file is the file against which all of the other files are compared.

Only the Reference - All and Reference - Peak Table analyses use a reference file.

The Results Table updates to show the selected analysis or the system suitability report.
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If All Data (not displayed) is selected, then the Results Table is empty. To view the results,
click Save to save the results to a comma-separated file, and then open the file in another
program.

5. (Optional) Repeat step 4 to use a different reference file or view a different type of analysis.

6. (Optional) Click Save.
The Results Table is saved to a comma-separated text file. Only the columns that are shown
in the table are saved.

Note: To save the system suitability results, click File > Save Report. The results are saved
as a PDF.

7. (Optional) Click File > Print.
The contents of the Overlay tab are printed in the current report template.

8. (Optional) In the File toolbar, right-click , and then select Save (all).
All changes to the results and the analysis parameters are saved to the data files.

9. In the File toolbar, right-click , and then select Close (all).
All of the data files close.

Guidance for Developing Acceptance Criteria
Acceptance criteria that are created for use with this kit for SOPs or other purposes should be
based on parameters inherent to the quality of the separation and attributes that reflect critical
sample qualities. Differences between gel and capillary lots and different systems might lead to
variation in absolute migration times.

Main peak purity and the ratio of total basic variants to total acidic variants (expressed as area %
of peak) are commonly accepted system suitability criteria for capillary isoelectric focusing (cIEF)
analysis. In addition, calculated pI is often used as a system suitability criterion. SCIEX does not
recommend using calculated pI because it depends on the sample mixture and is influenced by
variation between different lots of chemicals used in cIEF.

Estimating pI from the pI Markers
The pI markers in the sample are used to calibrate the X-axis and calculate the experimental pI
of an unknown protein. After calibration, the pI is displayed as Cal MT in the Results Table and
in the annotations on the graph, if shown. The X-axis can also be labeled to show pI instead of
migration time.

Tips for Best Results
We recommend the use of at least three pI markers close to the pI of the protein sample to verify
the linearity of the pH gradient. The protein should focus at a pI that is between the pI markers.
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From the pH gradient, the pI value of the protein sample can be determined. However, if a pI
marker co-migrates with the protein sample, it will interfere with the calculation of corrected peak
area (%). pI markers should be close to the pI of the sample but should not co-migrate.

To generate cIEF separations with high resolution and reproducibility, optimize the following:

• Composition of the protein sample:

• The protein sample must not contain more than 50 mM of salt because salt can affect the
formation of the pH gradient. If the salt concentration is more than 50 mM, then perform a
buffer exchange. Refer to Perform a Buffer Exchange (Optional).

• The protein sample must not be in an amphoteric buffer. If amphoteric buffer is present,
then it will focus and distort the pH gradient. If the sample is in an amphoteric buffer, then
perform a buffer exchange. Refer to Perform a Buffer Exchange (Optional).

• Quantity of protein: Make sure that there is enough protein to be detected by UV
absorbance at 280 nm. Too much protein can lead to protein precipitation, aggregation, and
shorten capillary run-life.

• Urea concentration: If required, and if the protein has low solubility, add urea to the sample
to increase its solubility. This minimizes protein precipitation and aggregation, which can
shorten capillary run-life. Too much urea can lead to protein denaturation and precipitation.

• Quantity of ampholytes: The resolution increases with the quantity of ampholyte but too
much ampholyte can delay the formation of the pH gradient.

• Type of ampholytes: To increase resolution, use ampholytes with a narrower range.
Ampholytes from different vendors might provide different results, such as a different
resolution, a different focusing rates, or a different baseline background. After changing
ampholytes, optimize the amount of cathodic and anodic stabilizers, the focusing time, and
the voltage.

• Quantity of cathodic stabilizer: Add enough cathodic stabilizer to form the pH gradient
before the sample reaches the cartridge window. Too much cathodic stabilizer can distort the
pH gradient and decrease the peak resolution.

• Quantity of anodic stabilizer: Add anodic stabilizer when analyzing acidic proteins to
prevent protein loss in the anolyte vial and to minimize peak distortion. Too much anodic
stabilizer can distort the pH gradient decrease the peak resolution.

• Focusing time and voltage: Make sure that the focusing time in the separation method is
set long enough to prevent the sample peaks from splitting. A long focusing time can cause
the pH gradient to collapse before mobilization, resulting in irreproducible results and lower
peak resolution.

For more information, refer to References.
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Run the Samples with the Waters
Empower™ Software 9
This section gives instructions for the use of the Waters Empower™ software and the BioPhase
8800 driver for Empower™ with the BioPhase 8800 system.

Import the BioPhase Software Methods to Create
the Instrument Methods
Note: Methods created with the BioPhase software are supplied with the BioPhase 8800 driver
for Empower™. The methods are also available for download from the SCIEX web site. Refer to
the section: Download and Configure the Required Files (Waters Empower™ Software).

Instrument methods can also be created in the Method Editors for BioPhase System software.
Refer to the documents: Operator Guide and Software Help System.

Typically, three types of methods are required: a conditioning method, a separation method, and
a shutdown method. For some workflows, there are additional methods.

The following methods are available.

• Conditioning methods:

• cIEF New Cartridge Condition: Conditions the capillaries in a new cartridge.

• cIEF Condition: Conditions the capillaries as part of a sequence.

• cIEF Separation: Does the separation with the recommended cIEF sample composition with
Pharmalyte pH 3-10 carrier ampholytes.

• cIEF Shutdown: Cleans the capillaries at the end of a run, rinses the capillaries for storage,
and then turns off the lamp.

Use the following steps to import the BioPhase software methods and create instrument
methods and method sets to be used with the Waters Empower™ software.

1. In the Waters Empower™ Software Project window, click File > New Method > Instrument
Method.
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Figure 9-1 Select Desired Chromatography System Dialog

2. Click the system to be used, and then click OK.

The Instrument Method Editor opens.

3. Click Import, and then browse to the conditioning method.
The method opens in the Instrument Method Editor window with the Method Settings tab in
front.

Note: This window is read-only. If changes to the method are required, then save the
instrument method, and then edit the method in the Method Editors for BioPhase System
software. Refer to the section: "Edit an Existing Instrument Method" in the document:
Software Help.
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Figure 9-2 Method Settings Tab in the Instrument Method Editor

4. (Optional) Open the Method Program tab to see the actions.

5. To see the parameters for an action, click the row in the table.
The Parameters pane updates to show the parameters.
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Figure 9-3 Method Program Tab in the Instrument Method Editor

6. Save the conditioning instrument method.

a. Click File > Save with Method Set.
The Save current Instrument Method dialog opens.

b. In the Name field, type a name.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Although some versions
of the Waters Empower™ software accept more than 30 characters and other special
characters, if the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.

c. (Optional) In the Method Comments field, type the information.

d. If prompted, in the Password field, type the Waters Empower™ software password for
the current user, and then click Save.

The instrument method and method set are saved to the current project.

7. Click File > Exit.

Note: After a method has been imported, the Import button in the Instrument Method Editor
window is not available unless the window is closed and then opened.

8. Repeat steps 3 through 7 to create the other instrument methods and method sets.
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Create the Sample Set Method
The following instructions create a sample set method for eight samples, the number of wells in
one column in a sample plate.

Note: A sample set method requires method sets. Make sure that any required instrument
method is part of a method set.

1. In the Waters Empower™ Software Run Samples window, click BioPhase 8800 > BioPhase
Sample Set Editor.

The Method Editors for BioPhase System software opens, with the Sample Set Method
Editor workspace shown.

2. Click New Sample Set Method.
The Sample Set Method Editor opens with the Sample Plate Setup tab shown.

3. In first row of the Sample Set Summary table, click the Method Set Name cell, and then
select cIEF Condition.

4. In the Sample Plate Layout pane, click 1.
The first column in the sample plate is selected and the Sample Set Summary table updates
to show the selected wells.

Figure 9-4 Sample Plate Layout Pane
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5. Add the required sample information to the Sample Set Summary table. In rows 2 through 9,
do the following:

a. In the Sample Name cell, type a name for the sample.

b. Click the Method Set Name cell, and then select cIEF Separation from the list.

Tip! After selecting the method set for row 2, right-click and select Apply method to all
samples in column to assign the method to all of the samples.

6. In the last row, click the Method Set Name cell, and then select cIEF Shutdown.

Figure 9-5 Sample Set Summary Table

7. If the Validation pane is shown, then click the pane to see the errors. Click an error to
highlight the location where it occurs, and then make the required change.
If no errors are present, then the Validation pane is not shown.

8. Save the sample set method.

a. Click SAVE AS.

Note: The SAVE AS button is not available if there are errors. Resolve all of the errors
in the Validation pane, and then click SAVE AS.

The Save Sample Set dialog opens.

b. Type a name in the Sample Set Name field.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Although some versions
of the Waters Empower™ software accept more than 30 characters and other special
characters, if the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.
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c. (Optional) Type information in the Description field.

d. Click Save, and then click OK to acknowledge the saved method.

The sample set method is saved to the Waters Empower™ software database.

9. To see, save, or print the plate layouts:

a. Open the Plate Layouts tab.

b. (Optional) Click PRINT.
The Print Preview window opens.

c. As required, click the buttons to print or save the plate layouts.
Refer to the section: "Print Preview Dialog" in the document: Software Help System.

d. Click the close box, the × in the top right corner.
The Print Preview dialog closes.

10. In the Method Editors for BioPhase System window, click the close box, the × in the top right
corner.
The Method Editors for BioPhase System software closes and the Run Samples window is
shown.

Start the Sample Set Method
1. Load the cartridge and the plates. Refer to the section: Prepare the BioPhase 8800 System.

2. In the Waters Empower™ software Project window, click Tools > Run Samples.

Figure 9-6 Select Desired Chromatography System Dialog

3. Click the system to be used, and then click OK.
The Run Samples window opens.
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4. Configure the plate type.

a. Click Edit > Plates.

Figure 9-7 Define Plates for Sample Set Method Dialog

Note: If the dialog does not look like the preceding figure, then clear the 2790 Layout
check box.

b. Click the Plate Type Name cell, and then select ANSI-96well2mL.
The dialog updates with an image of the plate and buttons for the plate sequencing
mode.

c. Click the Plate Layout Position cell, and then type 1.

d. Click  to indicate the order that the wells are accessed during the run.

e. Click OK to save the changes, and then close the dialog.

Tip! To permanently configure the plate type, click Customize > Defaults, click Plates, do
steps 4.b through 4.e, and then click OK.

In the Sample Set Method table, the heading for the Vials column changes to Plate/Well.

5. Click  (Load Sample Set).
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Figure 9-8 Load Samples Dialog

6. Click Load using a previously created sample set method, and then click OK.

Figure 9-9 Open an existing sample set method Dialog

7. Click cIEF Kit Sample Set Method in the list, and then click Open.
The sample set method opens in the Samples tab.

8. (Optional) Configure the table to show only the columns that are relevant for the BioPhase
8800 system.
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a. Right-click, and then select Table Properties.
The Table Properties dialog opens.

b. Click Hide All, and then clear the check boxes for Plate/Well, # of Injs, SampleName,
Function, and Method Set / Report or Export Method.

c. Click OK.

The table updates to show the selected columns.

Figure 9-10 Samples Tab

9. Review the sample set method. Make sure that the correct reagent plate layout was used. If
any changes are required, then edit the method in the Method Editors for BioPhase System
software. Any changes to the instrument methods or method sets automatically propagate
to the sample set method.

10. In the Waters Empower™ Software Project window, click  (Start).
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Figure 9-11 Run Sample Set Dialog

11. If required, edit the information in the Run Sample Set dialog.

a. If required, edit the Name for this sample set field.

b. (Optional) Click Shutdown Method, and then select an instrument method that rinses
the capillaries.
If available, use a SCIEX-provided rinse method. If a rinse method is not available,
then create one. Use the same reagent set as the sample set method and the following
parameters:

• Pressure: 50 psi

• Duration: 2 min

• Inlet: Water

• Outlet: Waste

If the system encounters an error during a run, then it executes this instrument method,
and then stops the run.
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c. If required, select Do Not Run Shutdown Method During User Abort.

d. Click Run.

The run starts. During the run, the text in the row in the Sample Set Method window for the
sample being acquired is red.

CAUTION: Potential Data Loss. Do not initiate any actions from the BioPhase 8800
driver for Empower™ Direct Control pane during a run, even if the system status is
idle. Any actions might interfere with data acquisition.

Monitor the Run in the Waters Empower™

Software
Use this procedure to monitor the progress of the sample set method, and then, if required,
pause or stop it.

Note: Most of the panes in the Waters Empower™ software are designed for chromatography.
Use the following steps to monitor the progress of the capillary electrophoresis separation and
disregard information in the Time Remaining and Solvent Required panes.

1. If a problem is detected, to stop the run, click  (Abort).

CAUTION: Potential Data Loss. Do not stop the run until all of the data is saved. The
data is saved when the sample set method is on the next row.

Note: Do not use the Stop button in the Direct Control pane. That button only operates on
functions initiated from the Direct Control pane.
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Figure 9-12 Abort Options Dialog

CAUTION: Potential System Damage. If the run is stopped and will not be resumed,
then use the shutdown method to rinse the capillaries before storing the cartridge. If
the capillaries are not rinsed, electrolyte salt crystals or precipitate can accumulate
and might cause plugged capillaries, improper pressure sealing, errors when
injecting samples, arcing, or current leakage.

CAUTION: Potential System Damage. Before starting the run again, make sure to
empty or replace the outlet plate to prevent overflow of reagent and possible damage
to the instrument.

CAUTION: Potential Wrong Result. Before starting the run again, prepare new reagent
plates. If the run has been stopped, then there might not be enough reagents
available to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, then before starting the run again, discard them. The samples
might have degraded.

When the run ends, the text in all of the rows in the Sample Set Method window is red.

2. To view the data while it is acquired, in the Direct Control pane, click  (Monitor).
The Trace View window opens, and then the data is shown.
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Figure 9-13 Trace View Window

3. If required, do any of the following:

• To view current, voltage, or pressure, open the applicable tab in the top left.

• To view one graph with the data for all of the capillaries, in the bottom left click Overlay.

• To view data for specific capillaries, select or clear the check boxes at the bottom of the
window to select the capillaries of interest.

• To view the time and detector values for any point on a trace, click the trace at the
position of interest.

• To zoom in on the data, make sure that Overlay is selected, and then drag to select the
area to zoom. The mouse scroll wheel can also be used to zoom.

• To return the data to the original dimensions, in the bottom right click Reset Zoom.

• To view a different area of a zoomed plot, right-click the X- or Y-axis and then drag.

4. If required, at the bottom right click Auto Zero.
The detector signal is set to zero.

5. Wait until the Abort button ( ) changes from red to green ( ).
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There might be a delay between data acquisition and when all of the data is saved. The
green button indicates when all of the data is saved.

6. As required, dispose of samples and reagents. Refer to the section: Waste Disposal.

7. As required, store the cartridge. Refer to the section: Store the Cartridge After the Run.
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Troubleshooting 10
After each corrective action is complete, we recommend doing the analysis again to make sure
that the symptom has been corrected.

Symptom Possible Cause Corrective Action

Cartridge not
detected error

1. The ID chip on the cartridge is
not clean.

2. The contact pins on the
system are not clean.

3. The BioPhase 8800 system
firmware is not up to date.

1. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
wipe the surface of the ID chip.
Let the ID chip air dry before
installing the cartridge.

2. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
wipe the contact pins. Let the
pins air dry before installing the
cartridge.

3. Do the following:

a. On the BioPhase 8800
system front panel, touch
the icon in the upper left
corner.

b. Record the firmware
version.

c. Contact sciex.com/request-
support.
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Symptom Possible Cause Corrective Action

Error encountered
at beginning of run

1. The optical scan at the
beginning of the run failed
because of condensation on
the cartridge window.

2. Opening and closing the
optics door caused a sensor
error.

1. In the shutdown method,
increase the Sample Storage
temperature to 20 °C to prevent
condensation.

2. Turn off, and then turn on the
BioPhase 8800 system. Make
sure to follow the procedure to
change UV filters and do not
open the optics door except as
instructed. Refer to the section:
"Install a UV Filter" in the
document: Operator Guide.
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Symptom Possible Cause Corrective Action

Electrical current at
start of focusing
step changes
between replicate
runs

1. The sample is not mixed
correctly.

2. The protein is precipitating or
aggregating.

3. The capillary coating is
damaged.

4. The sample is degrading.

1. Prepare the sample again,
with the recommended
concentration. Make sure that
the sample is mixed sufficiently.

2. Do one or all of the following:

• Increase the amount of
protein solubilizer in the
sample.

• Decrease the protein
concentration in the sample.

• Use narrow-range
ampholytes.

3. Refer to the section: Assess
Capillary for Damaged Neutral
Coating.

4. Prepare the sample again,
with the recommended
concentration. Do the following:

• Keep the sample at a low
temperature, such as 10 °C
(50 °F).

• If the sample contains urea,
refer to the section: Prepare
the 4 M Urea-cIEF Gel
Solution.

Low resolution of
protein sample

1. The protein sample is not
sufficiently solubilized.

2. The capillary coating is
damaged.

1. Optimize the amount of protein
solubilizer in the sample to
minimize protein precipitation or
aggregation. Refer to technical
notes on the SCIEX website
or contact a SCIEX Field
Applications Specialist.

2. Refer to the section: Assess
Capillary for Damaged Neutral
Coating.
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Symptom Possible Cause Corrective Action

Low protein signal 1. The capillary coating is
damaged.

2. The protein is precipitating or
aggregating.

3. The protein is degrading
because the sample is too
basic.

4. The protein is denaturing
because there is too much
urea in the sample.

5. The protein concentration is
too low.

1. Refer to the section: Assess
Capillary for Damaged Neutral
Coating.

2. Do one or all of the following:

• Increase the amount of
protein solubilizer in the
sample.

• Decrease the protein
concentration in the sample.

• Use narrow-range
ampholytes.

3. Decrease the amount of cIEF
Cathodic Stabilizer in the
sample.

4. Decrease the amount of urea
in the sample. Refer to the
sections: Tips for Best Results
and References.

5. Prepare the sample again,
with the recommended
concentration. Add a larger
volume of the protein solution.
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Symptom Possible Cause Corrective Action

Missing peaks in
electropherogram
sample

1. A pipetting error occurred
during preparation of the
sample or master mix.

2. The method parameters are
incorrect.

3. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

1. Prepare a new sample or
master mix.

2. Do the following:

• In Method Settings, make
sure that the value for
Detector Type is correct.

• In the separation method,
make sure that the values
for Type of Injection and
Duration are correct.

• In the separation method,
make sure that the value for
Wavelength is 280 nm.

3. Make sure that the positions of
the samples in the sample plate
agree with the plate layouts. If
the positions are not correct,
then prepare the plates again
according to the plate layout.
Refer to the section: Reagents,
Plate Layouts, and Methods.
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Symptom Possible Cause Corrective Action

No electrical current
during separation

1. The capillary is damaged.

2. The electrode is broken or
bent.

3. The capillary end is blocked
or contaminated.

4. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

5. A capillary is filled with air
bubbles.

1. Refer to the section: Options
for a Blocked or Damaged
Capillary.

2. Replace the cartridge.

3. Refer to the section: Remove
Blockage from a Capillary.

4. Make sure that the positions
of the samples and reagents
in the plates agree with the
plate layouts. If the positions
are not correct, then prepare
the plates again according to
the plate layout. Refer to the
section: Plate Layouts.

5. Do one or all of the following:

• Make sure that the wells
of the sample and reagent
plates contain sufficient
solution.

• Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are
not correct, then prepare the
plates again according to the
plate layout. Refer to the
section: Plate Layouts.

• Use a centrifuge to spin the
plate for 5 min at 30 g to
remove air bubbles.
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Symptom Possible Cause Corrective Action

No peaks 1. The lifetime of the UV lamp
has been exceeded.

2. The method parameters are
incorrect.

3. There is no sample in a
sample well, or the position
of the samples in the sample
plate do not agree with the
plate layouts in the sequence.

4. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

5. The salt concentration in the
sample is too high.

6. The capillary window is
blocked.

1. Refer to the section: "Install a
UV Lamp" in the document:
Operator Guide.

2. Do the following:

• In Global Settings, make
sure that the value for
Detector Type is UV.

• In the separation method,
make sure that the value for
Wavelength is 280 nm.

• In the separation methods
for focusing and mobilization,
make sure that the value for
Polarity is Normal.

3. Make sure that the position of
the samples in the sample plate
agrees with the plate layout.
Refer to the section: Plate
Layouts.

4. Make sure that the position of
the samples in the sample plate
agrees with the plate layout. If
the positions are not correct,
then prepare the plates again
according to the plate layout.
Refer to the section: Plate
Layouts.

5. Do a buffer exchange for the
sample buffer to decrease the
salt concentration to 50 mM
or less. Refer to the section:
Perform a Buffer Exchange
(Optional).

6. Examine the capillary window.
Make sure that the window is
clean and the path is clear.
Refer to the section: Examine
the Capillary Cartridge.
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Symptom Possible Cause Corrective Action

No peaks
(continued)

1. The sample focused beyond
the capillary window because
there is not sufficient cathodic
stabilizer in the sample.

2. The capillary is blocked.

3. There is no sample in a
sample well, or the position
of the samples in the sample
plate do not agree with the
plate layouts in the sequence.

4. A pipetting error occurred
during preparation of the
sample.

1. Increase the amount of cathodic
stabilizer in the sample. Refer
to the section: Prepare the
Cathodic Stabilizer Solution.

2. Refer to the section: Remove
Blockage from a Capillary.

3. Make sure that the position of
the samples in the sample plate
agrees with the plate layout. If
the positions are not correct,
then prepare the plates again
according to the plate layout.
Refer to the section: Plate
Layouts.

4. Prepare a new sample or
master mix.
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Symptom Possible Cause Corrective Action

Peak profile
changes between
consecutive runs

1. Focusing is not complete.

2. The protein is precipitating or
aggregating.

3. The protein sample is not
stable.

4. The pH gradient is degrading
because of over-focusing.

5. The capillary coating is
damaged.

1. Increase the focusing time or
voltage.

2. Do one or all of the following:

• Increase the amount of
protein solubilizer in the
sample.

• Decrease the protein
concentration in the sample.

• Use narrow-range
ampholytes.

3. Optimize the sample
composition for protein stability.
Refer to technical notes on
the SCIEX website or contact
a SCIEX field applications
scientist.

4. Decrease the focusing time or
voltage.

5. Refer to the section: Assess
Capillary for Damaged Neutral
Coating.

Remove Blockage from a Capillary
1. Rinse the capillary with CE Grade Water for 10 min at 75 psi.

2. Use CE Grade Water to clean the capillary inlets.

3. Use a lint-free laboratory wipe to wipe the capillary inlets carefully in an outward direction.

4. If the blockage cannot be removed, then either edit the sequence to omit the damaged
capillary or replace the cartridge.

Options for a Blocked or Damaged Capillary
If blockage in a capillary cannot be removed or a capillary is damaged, then edit the sequence to
omit the blocked or damaged capillary. Refer to the section: Create the Sequence.

Troubleshooting
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Assess Capillary for Damaged Neutral Coating
1. Look for the following signs that the neutral coating of the capillary is damaged:

• Peaks are mobilized earlier because of electroosmotic flow (EOF).

• Peaks take longer to focus.

• Split peaks occur because of incomplete focusing.

• Sample peaks focus between the detection window and the capillary outlet during
focusing and are not detected during mobilization.

2. If the neutral coating of the capillary is damaged, refer to Options for a Blocked or Damaged
Capillary.

Troubleshooting
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Hazardous Substance Information A
The following information must be noted and the relevant safety measures taken. Refer to the
respective safety data sheets for more information. The safety data sheets are available upon
request or can be downloaded from our website, at sciex.com/tech-regulatory.

Hazard classification according to HCS 2012.

cIEF Anodic Stabilizer

WARNING! Causes serious eye irritation. Causes skin irritation. May cause
respiratory irritation.

cIEF Anolyte

DANGER! Causes severe skin burns and eye damage.

cIEF Catholyte

DANGER! Causes severe skin burns and eye damage.

cIEF Chemical Mobilizer

WARNING! Causes serious eye irritation and skin irritation.

cIEF Formamide

DANGER! May damage fertility or the unborn child.

cIEF Gel

WARNING! May be harmful if swallowed.

Hazardous Substance Information
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cIEF Neutral Capillary Conditioning Solution

WARNING! Causes serious eye irritation and skin irritation.

Other Reagents

These components are not classified as hazardous:

• CE Grade Water

• cIEF Cathodic Stabilizer

• cIEF Peptide Marker Kit

• cIEF Urea

For reagents from other vendors, read the safety data sheet from the vendor before use.
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Download Required Files C
Depending on the software in use, the steps are different.

• BioPhase software users, refer to the section: Download and Configure the Required Files
(BioPhase Software).

• Waters Empower™ software users, refer to the section: Download and Configure the Required
Files (Waters Empower™ Software).

Download and Configure the Required Files
(BioPhase Software)
Files with methods, sequences, reagents, and analysis parameters for the Capillary Isoelectric
Focusing (cIEF) Kit are available on sciex.com. Use the following instructions to download the
files, and then copy them to the appropriate location.

Note: The following procedure is only required when BioPhase software version 1.1 is being
used. The required files for the Capillary Isoelectric Focusing (cIEF) Kit are included as part of
the BioPhase software version 1.2 or later.

1. Go to sciex.com/software-support/software-downloads, and then click BioPhase
Resources in the More software downloads section.

2. Click BioPhase Project Files 1.2.

3. In File Explorer, right-click the BioPhase 1.2.zip file, and then click Extract All to
extract the installation package.

4. Browse to a location, click Select Folder, and then click Extract.
The extracted files are copied to the selected file path.

5. Put the extracted files in the correct locations. Do the following:

Note: The following instructions assume that the BioPhase software project folders are
located in the default location: C:\Biophase. If the project folders are in a different
location, then put the extracted files in that location.

a. Drag the BioPhase 1.2\Projects\cIEF folder to C:\BioPhase\Projects.

b. Drag the BioPhase 1.2\Reagents\cIEF folder to C:\BioPhase\Reagents.

c. Drag the BioPhase 1.2\Data Analysis\cIEF folder to C:\BioPhase\Data
Analysis.
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Download and Configure the Required Files
(Waters Empower™ Software)
Required files for the Capillary Isoelectric Focusing (cIEF) Kit are available on sciex.com. Use
the following instructions to download the files, and then copy them to the appropriate location.

1. Go to sciex.com/software-support/software-downloads, and then, in the More software
downloads section, click BioPhase Driver Resources.

2. Click BioPhase Method Files 1.3.

3. In File Explorer, right-click the BioPhase-Empower-Method-Files-1.3.zip file, and
then click Extract All.

4. Browse to the location to save the method files, click Select Folder, and then click Extract.
The extracted files are extracted and copied to the specified location.

Download Required Files
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Reagents, Plate Layouts, and
Methods D
Reagent Set
If the reagents are not available, then use the following figures to create a new reagent set.
Refer to the figures: Figure D-1 and Figure D-2.

Figure D-1 Capillary Isoelectric Focusing (cIEF) Kit Inlet Reagents

Reagents, Plate Layouts, and Methods
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Figure D-2 Capillary Isoelectric Focusing (cIEF) Kit Outlet Reagents

Plate Layouts
Note: The following figures show the plate layouts corresponding to the sequence supplied with
the software. If additional samples have been added or the reagent positions have been edited,
then the following layouts are not correct.

Sample Plates

Note: The top row shows the layout for the sample outlet plate. The bottom section shows the
layout for the sample inlet plate.
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Figure D-3 Layouts for the Sample Inlet Plate and Sample Outlet Plate

Reagent Plates

Note: The top row shows the layout for the reagent outlet plate. The bottom section shows the
layout for the reagent inlet plate.
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Figure D-4 Layouts for the Reagent Inlet Plate and Reagent Outlet Plate
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Methods
For instructions for creating a method, refer to the document: Software Help System.

Method Settings
Note: Use these settings for all of the methods.

Figure D-5 Method Settings for Capillary Isoelectric Focusing (cIEF) Methods

Conditioning Method for a New Cartridge
Figure D-6 Actions the cIEF New Cartridge Condition Method
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Figure D-7 Summary of Actions in the cIEF New Cartridge Condition Method

Conditioning Method
Figure D-8 Actions in the cIEF Condition Method

Figure D-9 Summary of Actions in the cIEF Condition Method
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Separation Method
Figure D-10 Actions in Program Pane for the cIEF Separation Method
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Figure D-11 Summary of Actions in the cIEF Separation Method
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Shutdown Method
Figure D-12 Actions in the Program Pane for cIEF Shutdown Method

Figure D-13 Summary of Actions in the cIEF Shutdown Method
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, United Kingdom, and Germany have access to the online store,
but access will be extended to other countries in the future. For customers in other countries,
contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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